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Microsoft Word 2000
Mail Merge

Overview

Word’s Mail Merge feature allows you to easily create form letters, envelopes, or mailing
labels. The Mail Merge Helper guides you through organizing the address data, merging
it into a generic document, and printing personalized documents.

Creating the Form Letter

Type the Form Letter
Open a new file in Word and enter text that will comprise the letter.

Mail Merge Information
As you are entering text, keep in mind that the name and address will be inserted from
the data source.

Tip: For ease of adding merge fields later, type placeholders in the areas of the letter
where you want data inserted. An example of using placeholders:

Title Name
Address1
Address2

City, State Zip

Dear Title Last Name:

Inserting the Date Automatically
e Go to the Insert menu
e Select Date and Time...
e Choose a date format from the Available Format list
e If you want the date updated each time you make changes to the document,
check the box to Update Automatically

Format the Letter
Add any special formatting to the letter. For example, you may want to change the font
and size or make some text Bold or /talicized.

Save the Letter
Click the Save button on the Standard toolbar to open the Save As dialog box, give the
form letter a name, and then click Save. You can now leave the form letter open.



Mail Merge Helper

Open Mail-Merge Helper
e Go to the Tools menu
e Select Mail Merge...
e This opens the Mail Merge Helper dialog box

Step One: Main Document
e Click the Create button under the Main Document heading
e Choose Form Letters

Mail Merge Helper HE

Use this checklist to set up a mail merge, Begin by choosing the Creste ‘

-] E'H Main document
2 m'-ﬂf‘li---
Catalog...

|| Ehra

3 Qj‘ Marge the data with the document

Cancel

Active Window Prompt

A prompt box appears, asking whether you want to use the active window as the main
document or create a new main document.

Click Active Window. This tells Word to use the form letter we created in the previous
steps as your main document for the mail merge.

Microzoft Wosd [E

) Tocreste the form letters, you can use the active document: window Main Form
Letter.doc or & new document window,




Step Two: Data Source

Get Data
e Click the Get Data button under the Data source heading
e Choose a data source option from the drop-down list

Mail Merge Helper HE

The necd: step in setting up the mail merge is to specfy a data source,
Choose the Get Ciaka buthon.

] Eﬂ Main document:
Create = Edit =

Marge type: Form Letters
Main document: C:\My Documents)Main Form Letter.doc

2 Data source

Create Daka Source.
Open Data Source...
3 @i Use Address Book,,,

Cloza

Open Data Source
If you already have a database created, specify which one you want to use.
Note: Word is able to use date stored in an Access database or Word table.

Create Data Source
If you don't have an address database, you may create your own by using the mail-

merge feature.
Keep in mind that this will slow you down a bit because you have to enter a record for

each person to whom you want to send the form letter.

Choose a Database File

If you selected Open Data Source, you must locate the database or table file.

Select the file from the list box and click Open.

Tip: In order to see all types of files, make sure you have All Files selected in Files of
Type box.



Create Your Own Address List

If you selected Create Data Source, the Create Data Source dialog box opens.

Word displays common field names in the list box.

Fields represent different parts of the address record (such as name, city, state).

You may choose the fields you don't want to use in your data source or add new ones.

Create Data Source K E3

& mail merge data source is compased of roves of data. The first now is called the
header row. Each of the columns in bhe header row begins with a field name.

‘Word provides commonty used Fisld names in the kst below. You can add or remove
Field names to customize the hesder row.

Field name: Fiekd names in header row:

Edit the Field Names

Word provides you with a list of typical field names.

To remove a field from the list, such as HomePhone, select it and then click the
Remove Field Name button.

To add a field, enter it in the Field name text box and click the Add Field Name button.
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& mail merge dats sourcs i compesad of roves of data. Tha firsk row is callad the
header row. Each of the columns in the header row begins with a field name.

‘Wiord provides commonly used Fisld names in the list below. You can add or remowe
fiekd names to customize the header row.

Field name: Field names in header row:
Addross
= i .|
Add FieldName b | |Lacthiame
[W [elrvm
Acdrecs] L!
Remave Fiekd Name | |7 =l
M5 Query... [ x ] com |

Check the List

Use the Move buttons to reposition a field in the list box.

Click the field you move, and then click the appropriate Move arrow button (click Up to
move the item up in the list, click Down to move it down).

When you have edited the list to contain all the fields you want to use in the database
and positioned them just as you want them, click OK.

Give the Data Source a Name
The Save As dialog box opens so you can give the data source a name.
Type in a name for the address list in the File name text box and click Save.



Edit the Data Source
A prompt box appears telling you there are no data records.

To add records click the Edit Data Source button.
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9 The dista SoURCE you st creabed containg no data reconds. You can sdd new records
\':I’) to your data source by choosing the Edit Daba Sourcs button, or add mengs Fields to
o main diooeent by choosing the Edit Main Docurmert button.

Echt [iats Source I it (ain Diocument I

Enter the First Record

A Data Form opens onscreen and you can enter the first record.
The fields shown are based on those you specified.

To start entering the text for the first field, just start typing.

Use the Tab key to move from field to field and enter text

Drata Fonm ﬂn
FiestName: I il oK |
Lastiianme; A New I
Addressl:

o _ o |
State: Aegors |
Country:
_Sewsorze |
%]
Becord: M| A I'- ¥ I HI

Click Add New
Click the Add New button to continue adding records to your database.

Enter the Next Record
Repeat the process for additional records.

Move Between Records

To move back and forth between records you've previously entered, click the arrow
buttons at the bottom of the form.

You may edit the text within each field just like you edit document text.

Use the Backspace and Delete keys to fix mistakes.

Data Fomm nﬂ
Frsttiane: == :l ok |
Lasthlame: ilerd A New |
fddressl: 714 5. Chestrut Street
- frares _ o |
el 0 megoes |
PostalCods: 7Ee4
Country: LIS

_ dewsowee |
%]
fiecord: M| 4 |4 » | HI

Click OK
Click OK when you are finished entering all the records.



Merge Fields

You must tell Word where to place the name and address in the form.

When you perform the mail merge, Word inserts data from each record into the merge
fields, creating a letter for each person in the data source.

The Mail-Merge Toolbar
The Mail-Merge toolbar appears above your form letter.

o

J Insert Merge Field = | Insert Word Field = | e

Mot [ on B D33 e TR .

Insert the Merge Fields
e C(Click in the form letter where you want a field inserted.
e C(Click the Insert Merge Field drop-down list on the Mail-Merge toolbar.
e Choose fields one at a time to add to the form letter.

The Field Code
Word inserts the field code, surrounded by brackets, into the document.
Example: «FirstName» «LastName»

Sample Address:

«FirstNames» -« LastName» 1|
«JobTitles

«Addressl»q

«Citys, «States -«PostalCodex|
«Company:1|

1

Dear-«FirstNames |

Note: Be sure to include punctuation or spacing between field codes.



Step Three: Merge the Data with the Document

After completing the form letter, choosing or creating a data source, and inserting all the
necessary field codes into the document, you are ready to run a mail merge.

When you complete the merge, Word displays an individual document for each person
in your data source and the field codes fill to reflect data from that person's record.

Merge the Data

Open the Mail Merge Help by going to Tools/Mail Merge...

Click Merge under the Merge the Data with the Document heading
The Merge dialog box appears

Select merge to a new document

Records to be Merged
Use this option to choose which records you want to use with the mail merge.
You may choose all of the records or a range of records.

Blank Fields

You may also designate how the mail merge should handle blank fields in your records.
A good use for this is to get an address without spaces.

For example: everyone might not have an Address2 field.

By selecting Don’t print blank lines when data fields are empty, the address is displayed
without blank spaces.

Select the options you want to use, and then click Merge.

Click Merge
Marge T
Merge to: | Merge

Wﬂ Setup... |

~Records to be merged

&+ gl " Erom: I To: I Check Errars, ..

Cery Opkions., ..

Cancel |

~Wwhen merging records
%" Don't print blank lines when data fields are empky.
" Print blank lines when data Fields are empty.

Mo query options have been set,

Merged Data
Word merges your form letter with the fields you specified from the data source and
creates an individual letter for each record in your data source.

Save It

You can print the letters now or save them to print later.

To save the merge, open the File menu and select Save As.
Enter a file name in the Save As dialog box and click Save.



Using Mail Merge to Create Envelopes or Labels

Open the Mail Merge Helper
Go to the Tools menu and choose Mail Merge...

Select Envelopes or Labels
From the Mail-Merge Helper dialog box, click the Create button and choose Envelopes
or Mailing Labels from the list. The remainder of this tutorial will focus on envelopes.

Mail Merge Helper HE

Use this checklist to set up & mail merge, Bagin by choosing the Creste ‘

-] E'u Main dacument
Craste ™
Formn Letters, ..

- Maiing Labels. ..
25 EET—
Catalag...

3 Qi Merge the data with the: document

Cancel

Choose a New Document
From the prompt box that appears, click New Main Document to start the merge in a
new file.

MiciosotwWord

) Tocreste the snvekpes, you can use the active dooument windiow Documents o &
e document vandow,

I fuckie Window 1 Hew Msin Cocusent |

Select a Data Source
Click the Get Data button and choose your data source.
To use an existing data source, such as an Access database, select Open Data Source.

Select the File
From the Open Data Source dialog box, select the data source file you want to use and
click Open.

Set Up Main Document Prompt Box
Click Set Up Main Document.



Choose an Envelope Size

Select the envelope size you want to use from the Envelope Options dialog box by
clicking on the drop down arrow at the Envelope Size option.

Click OK to continue.

Envelope Dptions B Ed
[Erwedope Options || erinting Optins |
Ernvelape gize:
[size 11 (4 1/2 % 10 3/8 in) =
+IF maded in the
[T Dedivery poink barcode
T FIM-A courtesy rep o |
Delivery addross | ¢ Proview
Eock... i From jaft:  |Auto 5‘
Fromiop:  [nute = = L]
Retum sddress | —
Fort... i Fromleft:  |Auto E‘ —
Frombop:  |duto E‘ |
o cancel |

Enter Address Fields

Click the Insert Merge Field button to begin building the field codes you want to include
on each envelope in the merge.

Envelope address EHE

Choose the Insert Merge Field button bo insert merge fields into the
sample ervelope address. You can edit and Format the merge Fislds and
ket in the Sampls Envelope Address box.

Ingert Merge Field = Ircsert Postal Bar Code.., |

Samgle envelope address:

Choose a Field

From the list that appears, select the first field to appear on the envelope.
Continue entering fields, inserting punctuation or spaces where needed.
To start a new line, press Enter.

Click OK when finished entering all the necessary fields.



Open Mail Merge Helper
From the Mail Merge Helper dialog box, click the Merge button.

Mail Merge Helper HE

The main document and daka source are resdy bo merge, Choose the Merge
button to complete the merge.,

-] Main document

Create ™ Edi
Marge type: Envelopes
Main document: Documant T
2 Data source

3Ej Merge the data with the document
[Ceree 1| Query options... |

Opticns in effect:
Suppress Blank Lines in Addresses

Merge to new decument

Cloza

Choose the Records

To merge the envelopes to a new file so you can check them over before printing, leave
New Document selected.

You may also specify which records to merge; click All to create envelopes for every
person in the data source or specify which records to create.

When you're ready to perform the merge, click the Merge button.

Merge HE
et
T — - | g,
[ Records: to e marged 7

Fal  ©pom [ ot I Chack Efrors...
[ '¥hen merging recoeds

¥ Doon't prink blank nes when data fields are empty.

™ Print blark nes when data fislds are empty.
Mo queny options have been sat.

Envelopes Are Created
Word creates a file with envelopes for each person in your data source.
You may now print or save the file as needed.
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